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Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking between the ThinkTel SIP Trunking Service and an enterprise solution using
Avaya IP Office Release 9.1.

The ThinkTel SIP Trunking Service provides the enterprise with PSTN access via a SIP trunk
between the enterprise and the ThinkTel network as an alternative to legacy analog or digital
trunks. This approach generally results in lower cost for the enterprise.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the procedures for configuring an enterprise solution using Avaya
IP Office Release 9.1 to interoperate with the ThinkTel SIP Trunking Service.

The ThinkTel SIP Trunking Service referenced within these Application Notes is positioned for
customers who have an IP-PBX or IP-based network equipment with SIP functionality, but need a
network service to access the PSTN from the enterprise using IP transport to complete their solution.

The ThinkTel SIP Trunking Service will enable origination and termination of local, long-distance,
toll-free, international, and other types of calls across a single broadband IP connection. A SIP
signaling interface will be enabled to the Customer Premises Equipment (CPE).

For brevity, the remainder of this document sometimes uses ThinkTel to refer to the ThinkTel SIP
Trunking Service.

2. General Test Approach and Test Results

The general test approach was to connect a simulated enterprise site to the ThinkTel SIP Trunking
Service via the public Internet and exercise the features and functionality listed in Section 2.1. The
simulated enterprise site comprised of Avaya IP Office 500 V2 running Release 9.1 software, Avaya
Voicemail Pro messaging application, Avaya H.323 and SIP hard phones, and SIP-based Avaya
softphones. The Avaya IP Office connects directly to the ThinkTel network via the LAN2 port.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to
the interoperability of the tested products and their functionalities. DevConnect Compliance Testing
is not intended to substitute full product performance or feature testing performed by DevConnect
members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of
a DevConnect member’s solution.

2.1. Interoperability Compliance Testing

To verify SIP trunking interoperability, the following features and functionality were covered during
the interoperability compliance test:

e Establishment of the SIP Trunk

e SIP OPTIONS queries and responses

e Incoming PSTN calls (via the ThinkTel SIP trunk) to SIP and H.323 telephones at the
enterprise

e QOutgoing PSTN calls (via the ThinkTel SIP trunk) to SIP and H.323 telephones at the
enterprise

e Inbound and outbound PSTN calls to/from Avaya Communicator for Windows

e Various call types including: local, long distance, outbound toll-free, international (011 +
country code + number) and local directory assistance (411)

e G.711u and G.729a codecs

e Caller ID presentation and Caller 1D restriction

CTM; Reviewed: Solution & Interoperability Test Lab Application Notes 2 0f 43
SPOC 5/24/2016 ©2016 Avaya Inc. All Rights Reserved. ThinkIPO91



DTMF transmission using RFC 2833

Voicemail access and navigation for inbound and outbound calls
Voicemail message waiting indicator (MW1)

Telephony supplementary features such as hold and resume, call forward, transfer, and
conference

Twinning on inbound calls to PSTN mobile phones

Use of the SIP REFER method for call redirection to the PSTN
Inbound and outbound long-duration call stability

Inbound and outbound long hold time call stability

Response to incomplete call attempts and trunk busy or error conditions
T.38 fax

Items not supported or not tested include the following:

e Inbound toll-free and emergency calls (911) were not tested as part of the compliance test.

e ThinkTel does not support Operator (0) and Operator-Assisted (0 + 10-digits) calls.

e ThinkTel does not initiate a SIP session timer refresh. In the compliance test, session refresh
for active calls was initiated from the Avaya IP Office.

2.2. Test Results

Interoperability compliance testing of the ThinkTel SIP Trunking Service was completed with
successful results for all test cases with the exception of the observations/limitations described
below.

e OPTIONS Response — On the test circuit used for the compliance test, ThinkTel responded
to OPTIONS from Avaya IP Office with "401 Unauthorized". For ThinkTel to respond to
OPTIONS with “200 OK”, it requires that the OPTIONS message contain an Authorization
header, but Avaya IP Office cannot be configured to satisfy this requirement. However,
Avaya IP Office treats any response to OPTIONS as an indication that the far end is active
and responding; therefore it will not take the SIP connection to the far end out of service.
This OPTIONS response is listed here simply as an observation since it had no impact on the
status of the SIP connection between Avaya IP Office and ThinkTel.

e Codec Lockdown —When the SDP of an outbound call INVITE contained the codec list of
G.729a and G.711u in that preference order, ThinkTel's call connect "200 OK" contained the
same codecs in the same order in the SDP instead of the single preferred codec (G.729a).
However, when the SDP of an outbound INVITE contained the codec list in the order of
G.711u and G.729a, ThinkTel's call connect "200 OK" contained the single preferred codec
(G.711u). This difference in codec lockdown behavior is listed here simply as an observation
since there was no user impact.

e Unsupported Codec — When an outbound call was configured to use a codec unsupported
by ThinkTel, ThinkTel would return a “183 Session In Progress” message whose SDP
contained G.711u. Avaya IP Office would then terminate the call by issuing the CANCEL
message. While this behavior was acceptable, it would be more desirable for ThinkTel to
return an explicit status message, like "488 Not Acceptable Here" or "415 Media Type
Missing™ in response to the outbound INVITE.
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e Use of REFER and Call Disconnect (BYE) — When the SIP REFER method was used for
off-net call re-direction (e.g., call forward and call transfer), after accepting the REFER from
the enterprise and issuing a BYE, ThinkTel would send an INVITE towards the Avaya IP
Office caller. This INVITE would elicit an Avaya IP Office response of “481
Dialog/Transaction Does Not Exist” since the call had already been terminated by the
previous BYE. This behavior had no user impact.

2.3. Support

For technical support on ThinkTel SIP Trunking Service, contact ThinkTel at:
e Phone: 1 (866) 928-4465
e Email: support@thinktel.ca
e Website: http://support.thinktel.ca/

Avaya customers may obtain documentation and support for Avaya products by visiting
http://support.avaya.com. Alternatively, in the United States, (866) GO-AVAYA (866-462-8292)
provides access to overall sales and service support menus.
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3. Reference Configuration

Figure 1 illustrates the sample configuration used for the DevConnect compliance testing. The
sample configuration shows an enterprise site connected to the ThinkTel SIP Trunking Service.

Located at the enterprise is an Avaya IP Office 500 V2 running Release 9.1 software. Endpoints
include various Avaya IP Telephones (with H.323 and SIP firmware) and a SIP-based Avaya
softphone (Avaya Communicator for Windows). The site also has a Windows PC running Avaya
Voicemail Pro for providing voice messaging to the Avaya IP Office users, and Avaya IP Office
Manager for administering the Avaya IP Office.

Mobility Twinning is configured for some of the Avaya IP Office users so that calls to these user
phones will also ring and can be answered at the configured mobile phones.

Enterprise Site

ThinkTel

SIP Trunking
Service

Domain: tor.trk.tprm.ca

PSTN
Telephone

I
I
I
I
I
Fax I
+ 192.168.96.232

4 R
Avaya IP Office 500 v2 RIS
10.32.128.25
e Enterprise LAN | —
Avaya ;10011 200 Avaya 1600 Series
Avaya IP Office Avaya Seties IP IP Deskphone(s)
Manager Communicator Deskphone(s) (H.323)
for Windows (sIP)
Avaya IP Office (SIP)
Voicemail Pro ‘6
Avaya 9600 Series
X IP Deskphone(s)
DIDs:4385550976
4385550977 {H.323)
4385550978
4385550979
4385550980
S >
Figure 1: Test Configuration
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For security purposes, any actual public IP addresses used in the compliance test were changed to
192.168.x.x throughout these Application Notes.

For the purposes of the compliance test, users dialed a prefix digit 9 plus N digits to send an
outbound call to the number N across the SIP trunk to ThinkTel. The short code of 9 was stripped off
by Avaya IP Office but the remaining N digits were sent to the service provider network. For calls
within the North American Numbering Plan (NANP), the user dialed 11 (1 + 10) digits for long
distance and local calls. Thus, for these NANP calls, Avaya IP Office sent 11 digits in the Request
URI and the To header of an outbound SIP INVITE message. ThinkTel sent 10 digits in the Request
URI and the To header of inbound SIP INVITE messages.

In an actual customer configuration, the enterprise site may also include additional network
components between the service provider and the enterprise network such as a data firewall. A
complete discussion of the configuration of these devices is beyond the scope of these Application
Notes. However, it should be noted that SIP and RTP traffic between the service provider and Avaya
IP Office must be allowed to pass through these devices.

The administration of the Avaya Voicemail Pro messaging service and endpoints on Avaya IP Office
are standard. Since these configuration tasks are not directly related to the inter-operation with the
ThinkTel SIP Trunking Service, they are not included in these Application Notes.
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4. Equipment and Software Validated
The following equipment and software/firmware were used for the sample configuration provided:

Avaya Telephony Components

Equipment / Software Release / Version
Avaya IP Office 500 V2 9.1.5 Build 145
Avaya IP Office COMBO6210/ATM4 Module 9.1.5 Build 145
Avaya IP Office Manager 9.1.5 Build 145
Avaya Preferred Edition (a.k.a VVoicemail Pro) 9.1.5.02
Avaya 1140E IP Telephone (SIP) 4.4 SP2 (4.04.18)
Avaya 1616 IP Deskphone (H.323) running 1.3 SP5 (1.3.50B)
Avaya one-X® Deskphone Value Edition
Avaya 9641G IP Deskphone (H.323) running 6.6.0 (6.6.0.29)
Avaya one-X® Deskphone Edition
Avaya Communicator for Windows 2.0.3.30

ThinkTel Components

Equipment / Software Release / Version
Metaswitch 8.1
Opensips Session Border Controller 1.11.6 (LTS)

This compliance testing is applicable when the tested solution is deployed with a standalone Avaya
IP Office 500 V2 and also when deployed with all configurations of Avaya IP Office Server Edition
without T.38 Fax Service.

Avaya IP Office Server Edition requires an Expansion Avaya IP Office 500 V2 to support
analog/digital endpoints or trunks.
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5. Configure Avaya IP Office

Avaya IP Office is configured through the Avaya IP Office Manager PC application. From the PC
running Avaya IP Office Manager, select Start - Programs - IP Office - Manager to launch
the application. A screen that includes the following in the center may be displayed:

WELCOME to IP Office Administration

What would you like to do ?

Create an Offline Configuration

Open Confiquration from System

Read a Configuration from File

Select Open Configuration from System. If the above screen does not appear, the configuration
may be alternatively opened by navigating to File & Open Configuration at the top menu of the
Avaya IP Office Manager window. Select the proper Avaya IP Office system from the pop-up
window (not shown) and log in with the appropriate credentials.

The appearance of the Avaya IP Office Manager can be customized using the View menu. In the
screens presented in this document, the View menu was configured to show the Navigation pane on
the left side, omit the Group pane in the center, and show the Details pane on the right side. Since
the Group Pane has been omitted, its content is shown as submenus in the Navigation pane. These
panes (Navigation and Details) will be referenced throughout the Avaya IP Office configuration.

All licensing and feature configuration that is not directly related to the interface with the service
provider (such as twinning and Avaya Communicator for Windows support) is assumed to already
be in place.

In the sample configuration, Atlantic City was used as the system name. All navigation described in
the following sections (e.g., License = SIP Trunk Channels) appears as submenus underneath the
system name Atlantic City in the Navigation Pane. The configuration screens only highlight
values/settings configured for the compliance test. Defaults were used for other values and may be
customized based upon requirements in the field.

CTM; Reviewed: Solution & Interoperability Test Lab Application Notes 8 of 43
SPOC 5/24/2016 ©2016 Avaya Inc. All Rights Reserved. ThinkIPO91



5.1. Licensing and Physical Hardware

The configuration and features described in these Application Notes require Avaya IP Office to be
licensed appropriately. If a desired feature is not enabled or there is insufficient capacity, contact an
authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels license with sufficient capacity; click License in the
Navigation pane. Confirm a valid license with sufficient Instances (trunk channels) in the Details
pane.

IP Offices | g -8 X[ v<|s
@& BOOTP 2) License | Remote Server
#-¢# Operator (3) =
=% Atlantic City License Mode License Normal
i-+539 System (1)
& 17 Line (18) Licensed Version 91
<22 Control Unit (3) .
+ & Extension (25) Serial Number (ADI)
w-§  User(@7) —
=28 Group (1) PLDS Host ID
8% Short Code (64) PLDS File Status Not Present / Invalid
; @ Service (0)
o RAS (1)
* € Incoming Call Route (44) )
i £ WAN Port (0) Feature License Key Instances Status i ‘ Add...
- Directory (0) . h -
47 Time Profile (0) IP500 Voice Networking Channels 4 Valid r—
@@ Firewall Profile (1) VCM Channel Migration 255 Valid 2 =
& IP Route (4) SIP Trunk Channels 255 Valid I
;& Account Code (0) VPN IP Extensions 255 Obsolete
i ; = ’ (0; IP500 Universal PRI (Additional cha... 255 Valid
unnel . .
& §3 User Rights (8) RAS LRQ Support (Rapid Response) 255 Valid
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To view the physical hardware comprising the Avaya IP Office system, expand the components
under the Control Unit in the Navigation pane. In the sample configuration, the second component
listed is a Combination Card. This module has 6 digital station ports, two analog extension ports, 4
analog trunk ports and 10 VCM channels. The VCM is a Voice Compression Module supporting
VoIP codecs. An Avaya IP Office hardware configuration with a VCM component is necessary to
support SIP trunking.

To view the details of the component, select the component in the Navigation pane. The screen
below shows the details of the IP 500 V2.

IP Offices = IP 500 V2 - v <>
- K& BOOTP (2) Unit
- Operator (3]
-0 Atlantic City Device Number 1
% Systern (1) _
-1 Line (25) Unit Type o
=2 - Control Unit (3] )
e 11P 500 V2 Version B
; 2 COMBOB210/ATIMA Serial Nurnb
b 3 DIGSTAS/ATMY enat Humber
-4 Extension (25) . 1032.128.25
EJ-"I User (27) Unit IP Address
E]mﬂ Group (1) Interconnect Number 0
8% Short Code (64)
""" B service () Module Mumber Control Unit
ol RAS (1)
B Incoming Call Route (73)

The screen below shows the details of the Combination Card:

IP Offices = COMBO6210/ATM4 (& X vi<|>

=-R BOOTP (2) Unit

4% Operator (3)

-5 Atlantic City Device Mumber 2

=7 System (1)

-1 Line (25) Unit Type COMBOG210/ATM4

-2 Control Unit (3) _

s 11 500 V2 Version L
2 COMBOG6210/ATM4 I |
= 3 DIGSTAB/ATMA sl Rumber
(-4 Extension (25) .
Unit TP Add 0.0.0.0

w-§ User @M n ress

=5 Group (1) Interconnect Number 0

(-8 Short Code (64)

""" B Service () Module Number Contrel Unit
ol RAS (1)
-3 Incoming Call Route (73)
CTM; Reviewed: Solution & Interoperability Test Lab Application Notes 10 of 43

SPOC 5/24/2016 ©2016 Avaya Inc. All Rights Reserved. ThinkIPO91



5.2. System
This section configures the necessary system settings.

5.2.1. System — LAN2 Tab

In the sample configuration, the Avaya IP Office WAN (LANZ2) port was used to connect to the
public network. The LAN2 settings correspond to the WAN port on the Avaya IP Office 500 V2. To
access the LAN2 settings, first navigate to System = <Name>, where <Name> is the system name
assigned to the Avaya IP Office. In the case of the compliance test, the system name is Atlantic
City. Next, navigate to the LAN2 - LAN Settings tab in the Details Pane. Set the IP Address field
to the IP address assigned to the Avaya IP Office WAN port. Set the IP Mask field to the mask used

on the public network.

IP Offices

3

= Atlantic City

- K BOOTP (2)

i Operator (3)

=37 Atlantic City

- System (1)
L3y Atlantic City

----- 22 Directory (0)
..... £ Time Profile (0)
E]'"@' Firewall Profile (1)

SMDR | Twinning | VCM | Codecs | VolP Security | Contact Center|

Systemn | LAMNL | LANZ | DS |Voicemai| | Telephonyl Directory Services | System Events | SMTP |

LAN Settings |VoIP | NetworkTopology|

Mumber Of DHCP IP Addresses 2000 | =

#-T9 Line (25) IP Address 192 . 168 . 96 . 23
[#+“2r Contral Unit (3]

[ Extension (25) IP Mask 255 255 255 224
E-§  User (27)

E]---ﬁ Group (1) Primary Trans, IP Address 0 0 0 0
8% Short Code (64) _ .

,,,,, @ Service (0) Firewall Profile [<None> v]
ol RAS (1) .
- Incoming Call Route (73) | || o7 Mede [None ]

""" @ WaN Port (0) ] Enable NAT

- [§ll IP Route (4) DHCP Mode
""" 8w Account Code (0] ) Server () Client () Dialin @ Disabled Advanced
----- & Licensze (78)
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On the VoIP tab of LANZ in the Details Pane, configure the following parameters:

e Check the SIP Trunks Enable box to enable the configuration of SIP trunks.
e The RTP Port Number Range can be customized to a specific range of ports that Avaya IP
Office will use for RTP media. This port range will be used to select a destination port for

incoming RTP and a source port for outgoing RTP for calls using LANZ2. The default values
were used.

i
o

i= Atlantic City £ v | < s

VolP Security | Contact Center|

System | LAML | LANZ | DMS | Yoicemail |Telephony | Directory Services | System Events | SMTP | SMDR | Twinning | YCM | Codecs |
| LAN Settings| VoIP |Ne1:work Topology|

H323 Gatekeeper Enable

»

[ Auto-create Extn Auto-create User [7] H323 Remote Extn Enable

1720

| SIP Trunks Enable

[T] SIP Registrar Enable

m

Auto-create Extn/User SIP Remote Extn Enable

uppP 5060 : 5060
TCP 5060 : 5060 A
TLS 5061 : 5061
10
RTP
Port Mumber Range
Minimum 48152 = Maxirum 33246 =
Port Mumber Range (NAT)
Minimum 49152 = Maximum 53246 =
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Scroll down the page.

¢ Inthe Keepalives section, set the Scope to RTP. Set the periodic timeout to 30 and the
Initial keepalives parameter to Enabled. These settings will cause Avaya IP Office to send a
RTP keepalive packet starting at the time of initial connection and every 30 seconds
thereafter if no other RTP traffic is present. This facilitates the flow of media in cases where
each end of the connection is waiting to see media from the other, as well as helping to keep
firewall ports open for the duration of the call.

e Inthe DiffServ Settings section, Avaya IP Office can also be configured to mark the
Differentiated Services Code Point (DSCP) in the IP header with specific values to support
Quality of Services policies for both signaling and media. The DSCP field is the value used
for media and the SIG DSCP is the value used for signaling. The specific values used for the
compliance test were the Avaya IP Office default values and are shown in the screenshot
below. Quality of Service (QoS) is not specifically tested as part of the compliance test. For
a customer installation, if the default values are not sufficient, appropriate values should be
provided by the customer.

e All other parameters should be set according to customer requirements.

i= Atlantic City £ v <>

VolIP Security | Contact Center|
Systemn | LAMNL | LAN2 | DMNS | Voicemnail | Telephony | Directory Services | Systern Events | SMTP | SMDR | Twinning | YCM | Codecs |

| LAN Settings| VoIP | Network Topology|

Enable RTCP Monitoring on Port 5005 =
RTCP collector IP address for phones 0 0 0 0

Keepalives

Scope [RTP VI Periodic timeout 30

Initial keepalives IEnabIed VI

DiffServ Settings

B8 T DSCP{Hex) B8 +| Video DSCP{Hex) FC +| DSCP Mask (Hex) (88 T SIG DSCP (Hex)

46 || DscP 46 2| Video DSCP 63 2] DSCP Mask 34 2| sIGDSCP

DHCP Settings

Primary Site Specific Option Number (S50N) 176 =

Secondary Site Specific Option Mumber (S50N] 242 = E
wan

1100 Voice VLAN Site Specific Option Number (SS0N) 232 =

1100 Vioice VLAN IDs
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On the Network Topology tab of LAN2 in the Details Pane, configure the following parameters:

e Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. No firewall or network address translation (NAT) device was used in the
compliance test as shown in Figure 1, so the parameter was set to Open Internet. With the
Open Internet setting, STUN Server Address is not used.

e Set Binding Refresh Time (seconds) to the desired value. This value is used to determine
the frequency at which Avaya IP Office will send SIP OPTIONS messages to the service
provider. The compliance test used a value of 300 seconds.

e Set Public IP Address to the IP address of the Avaya IP Office WAN port.

e Set Public Port to 5060 for UDP.

= Atlantic City [ v | <>

VolIP Security | Contact Center|
System | LAMNL | LANZ | DNS |Voicemai| | Telephonyl Directory Services | System E\rentsl SMTP | SMDR | Twinning |VCM | Codecs |

| LAN Settings | VolP | Network Topolgy |
Metwork Topology Discovery
STUM Server Address 109016813 STUM Port 3478 =
Firewall/NAT Type [Open Internet - l
Binding Refresh Time (seconds) 300 =
Public IP Address 192 168 . 9% . 232 Cancel
Public Port
uDP 5060 =
TCP 0 =
TLS 0 =
[] Run STUM on startup
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5.2.2. System - Voicemail Tab

In the Voicemail tab of the Details Pane, configure the SIP Settings section. The SIP Name and
Contact are set to one of the DID numbers assigned to the enterprise from ThinkTel. The SIP Display
Name (Alias) parameter can optionally be configured with a descriptive name. Uncheck the Anonymous
box to allow the Voicemail Caller ID information to be sent to the network.

Note the selection in Voicemail Type and the IP address setting for Voicemail IP Address. These
are for configuring VVoicemail Pro as the voice messaging service for Avaya IP Office (part of the
standard Avaya IP Office setup beyond the scope of these Application Notes).

Atlantic City [ v | < =

T

Contact Center

System | LANL | LAN2 | DNS | Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR | Twinning | VCM | Codecs | volP security

Voicemail Type Woicemail Lite/Pro A [7] Messages Button Goes To Visual Voice
yp 9

Voicemail Destination Outcalling Control
Yoicemail [P Address 10 32 128 79

Backup Voicemail IP Address | 0 0 0 0
WYoicemail Channel Reservation

Unreserved Channels 259

L3

Auto-Attendant 0 +| Voice Recording [0

3

% Mandatery Voice Recerding |0

Announcements 0 | Mailbox Access |0 =

DTMF Breakout Voicemail Code Complexity

Reception / Breakout (DTMF 0) - Enforcement

Minimum length 3 =
Breakout (DTMF 2) - [7] Complexity

Breakout (DTMF 3) -

SIP Settings

SIP Name 4385550980
SIP Display Mame (Alias) Voicemail
Contact 4385550980

Anonymous &=

Call Recerding
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5.2.3. System - Telephony Tab

Navigate to the Telephony = Telephony tab in the Details Pane. Enter or select 0 for Hold
Timeout (secs) so that calls on hold will not time out. Choose the Companding Law typical for the
enterprise site. For the compliance test, U-Law was used. Uncheck the Inhibit Off-Switch
Forward/Transfer box to allow call forwarding and call transfer to the PSTN via the service
provider across the SIP trunk per customer business policies. Note that this configuration might pose
a security issue (Toll Fraud). Customers should exercise caution with this configuration.

= Atlantic City [ v o 2
WolP Security | Contact Center
System | LANL | LAN2 | DNS | Voicemail| Telephony | Directory Services | System Events | SMTP | SMDR | Twinning | VEM | Codecs |
Telephony | Park &Pagel Tones &Musicl Ring Tones | 5M | Call Log | TUI |
Analogue Extensions Companding Law i
Switch Line
Default Outside Call Sequence INormaI v]
Default Inside Call Sequence ’Ring Typel v] @ U-law @ U-Law Line
Default Ring Back Sequence lRing Type 2 v]
) . ) ) A-Law ) A-Law Line
Restrict Analogue Extension Ringer Voltage =
Dial Delay Time (secs) 4 = [ DSS Status
= /| Auto Hold
Dial Delay Count 0 = ute e
. = Dial By Name
Default Mo Answer Time (secs) 25 = B
- = Show Account Code
Hold Timeout (secs) 0 =
= [ Inhibit Off-Switch Forward,/ Transfer L
Park Timeout (secs) 300 = E
- [ Restrict Network Interconnect
Ring Delay (secs) 5 -
- Include lecation specific information
Call Priority Promotion Time (secs) |Disabled =
[C] Drop External Only Impromptu Conference
Default Currency [USD v]
[T] Visually Differentiate External Call
Default Mame Pricrity [Favor Trunk v]
[T] Unsupervised Analog Trunk Disconnect Handling
Media Connection Preservation [Disabled VI ) ) )
High Quality Conferencing
Phone Failback [Manual VI .
Digital/Analogue Auto Create User
Legin Code Complexity
Directory Overrides Barrin
[7] Enforcement a v g
4
Complexity | 4
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5.2.4. System - Twinning Tab

To view or change the System Twinning settings, navigate to the Twinning tab in the Details Pane
as shown in the following screen. The Send original calling party information for Mobile

Twinning box is not checked in the sample configuration, and the Calling party information for
Mobile Twinning is left blank.

W

= Atlantic City £ v | <>

| System | LANL | LAN2 | DNS | Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR |
Twinning | YCM | Codecs | VoIP Security | Contact Center|

[C] Send original calling party information for Maobile Twinning

Calling party informaticn for
Maebile Twinning

5.2.5. System — Codecs Tab

In the Codecs tab of the Details Pane, select or enter 101 for RFC2833 Default Payload. This setting
matched the ThinkTel configuration for use with out-of-band DTMF tone transmissions.

W

= Atlantic City () v | <|>

System | LANL | LAN2 | DNS | Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR |
Twinning | VCM Codecs | VolP Security | Contact Center|

RFC2833 Default Payload 101 -
Available Codecs Default Codec Selection
Unused Selected
G.711 ULAW 64K R G.711 ULAW a4k
G.711 ALAW 64K G.711 ALAW B4k

] G722 64K
G.729(a) 8K CS-ACELP
G.723.1 6K3 MP-MLQ

5.729(a) 8K C5-ACELP
G.723.1 6K2 MP-MLO

<

R
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5.3. IP Route

Navigate to IP Route - 0.0.0.0 in the left Navigation Pane if a default route already exists.
Otherwise, to create the default route, right-click on IP Route and select New. Create/verify a
default route with the following parameters:

e Set IP Address and IP Mask to 0.0.0.0.

e Set Gateway IP Address to the IP address of the enterprise LAN gateway for the subnet
where the Avaya IP Office is connected.

e Set Destination to LAN2 from the drop-down list.

i

fru)

----- BB WAN Port (0]

----- a5 Directory (0)

----- £ Time Profile (0)
&8} Firewall Profile (1)

]e Inceming Call Route

IP Offices = 0.0.0.0 ek - X | v <
- & BOOTP (2) IP Route
i« Operator (3)
=)-%38 Atlantic City IP Address 0 0 0 0
=558 System (1)
------ 9 Atlantic City 1P Mask ¢ 0 0 0
-4 Line (25) Gateway IP Address 192 . 168 96 254
[+ Control Unit (3]
[+-48 Extension (25) Destinaticn ’LANE -
- User (27)
-3 Group (1) Metric 0 =
8% Short Code (64)
----- @ Service (0) [T Proxy ARP
ol RAS (1)
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5.4. Administer SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and the ThinkTel SIP
Trunking Service. The recommended method for configuring a SIP Line is to use the template
associated with these Application Notes. The template is an .xml file that can be used by IP Office
Manager to create a SIP Line. Follow the steps in Section 5.4.1 to create the SIP Line from the
template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

IP addresses

SIP Credentials (if applicable)

SIP URI entries

Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary after
the SIP Line is created via the template. The resulting SIP Line settings can be verified against the
manual configuration shown in Sections 5.4.2 —5.4.8.

Also, the following SIP Line settings are not supported on Basic Edition:
e SIP Line — Originator number for forwarded and twinning calls

Transport — Second Explicit DNS Server

SIP Credentials — Registration Required

SIP Advanced

Engineering

To create a SIP Line manually, right-click Line in the Navigation Pane and select New > SIP Line;
then, follow the steps outlined in Sections 5.4.2 — 5.4.8.
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5.4.1. Create SIP Line from Template

1. Copy the template file to the computer where IP Office Manager is installed. Rename the

template file to AF_ThinkTel_SIPTrunk.xml. The file name is important in locating the
proper template file in Step 5.

2. Verify that template options are enabled in IP Office Manager. In IP Office Manager,
navigate to File > Preferences. In the IP Office Manager Preferences window that appears,

select the Visual Preferences tab. Verify that the option box is checked next to Enable
Template Options. Click OK.

g .
%" IP Office Manager Preferences M

1
|

l Preferences I Directories l Discovery | Visual Preferences ‘Security l Validationi

Icon Size [Small v]

[¥] Multiline Tabs
[¥] Enable Template Options

["] Enable Template Creation

i) 0K ‘ [ Cancel ’ ’ Help

3. Import the template into IP Office Manager. From IP Office Manager, select Tools =
Import Templates in Manager. This action will copy the template file into the IP Office
template directory and make the template available in the IP Office Manager pull-down

menus in Step 5. The default template location is C:\Program Files\Avaya\lP
Office\Manager\Templates.

2054 3 E Extension Renumber... ;
Line Renumber... =
IP Office
x Connect To... —
- #& BOOTP (1)
-7 Operator (3) Expot =
Atlantic City SCN Service User Management
’T‘{/ E?’::Eg\n(l) Busy on Held Validation
+“= Control Unit MSN Configuration
-4 Extension (2
*—t"'a User (27) Print Button Labels
t 2% Group (1) L Import Templates in Manager
(8% Short Code (097 e
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In the pop-up window (not shown) that appears, select the directory where the template file
was copied in Step 1. After the import is complete, a final import status pop-up window (not
shown) will appear stating success or failure. Click OK to continue.

If preferred, this step may be skipped if the template file is copied directly to the IP Office

template directory.

Note ~Windows 7 (and later) locks the Avaya IP Office 9.1 \Templates directory, and it
cannot be viewed. To enable browsing of the \Templates directory, open Windows Explorer,
navigate to C:\Program Files\Avaya\lP Office\Manager (or C:\Program Files

(x86)\Avaya\lP Office\Manager), and then click on the Compatibility files option shown
below. The \Templates directory and its contents can then be viewed.

@Qvl » Computer » Local Disk (C:) » Program Files » Avaya » IP Office » Manager » v | ZL
— — —
Organize ¥ Include in library v Burn New folder
X Favorites Name : Date modified Type
Bl Desktop de-DE 10/20/2014 10:08 ...  File folder
& Downloads en-US File folder
| Recent Places es-MX File folder
fr-FR File folder
4 Libraries IPSET-UNISTIM-C7M File folder
| Documents ) it-IT File folder
& Music LVMGreeting File folder
b=/ Pictures MemoryCards 10/20/201410:09 ..,  File folder
B Videos nl-NL 10/20/201410:08 ...  Filefolder
Phonelmages 10/20/2014 10:08 ...  File folder
«& Homegroup pt-BR 10/20/2014 10:08 ., File folder
ru-RU 10/20/2014 10:17 ...
1% Computer V3_2.999 2014 10:08 ..
’z;w Local Disk (C:) , zh-Hans 10/20/2014 10:08 ...  Filefolder
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4. To create the SIP Trunk from the template, right-click on Line in the Navigation Pane, then
navigate to New - New SIP Trunk from Template.

IP Offices = SIP Line
- & BOOTP () SIP Line Transport|SIP URI|VoIP | T38 Fax|SIP Creq
i Operator (3)
= Dﬁ«ﬂ% Y New . 2
DT:: |f| New SIP Trunk from Template | voip.sotel
g@ E;IE :‘1 Create 5IP Trunk Template SIp
g% g: é Cut Ctrl+X Cloud
9% Shg 533 Copy Ctrl+C
""" D Sen Paste Ctrl+V
g% IRri- 75 Delete Ctrl+Del
----- 8 wal '  Validate
: 'I[Eliri Connect To... Ctrl+T 0
EJ---@ Firel MNew frem Template (Binary) 00
-ElIPR Export as Template (Binary)
""" B AccounTCoue T CEURTTy Code

5. In the subsequent Template Type Selection pop-up window, select ThinkTel from the
Service Provider drop-down list as shown below. This value corresponds to part of the file
name (AF_ThinkTel_SIPTrunk.xml) created in Step 1. Click Create new SIP Trunk to
finish creating the trunk.

r - -
%" Template Type Selection e
Locale United States (LIS English]
Service Provider | ThinkTel v | [7] Display Al
I Create new SIP Trunk ] [ Cancel ]
A

6. Once the SIP Line is created, verify the configuration of the SIP Line with the configuration
shown in Sections 5.4.2 — 5.4.8.
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5.4.2. SIP Line — SIP Line Tab
In the SIP Line tab of the Details Pane, configure the parameters as shown below:

e Set the ITSP Domain Name to service provider domain provided by ThinkTel.
e Check the In Service box. This makes the trunk available to incoming and outgoing calls.
e Check the Check OOS box. Avaya IP Office will use the SIP OPTIONS method to
periodically check the SIP Line. The time between SIP OPTIONS sent by Avaya IP Office
will use the Binding Refresh Time for LAN2, as shown in Section 5.2.1.
e Set Refresh Method to Auto. With this setting, Avaya IP Office will send UPDATE
messages for session refresh if the remote party supports UPDATE. If UPDATE is not

supported, re-INVITE messages are sent.

e Set Timer (seconds) to a desired value. With the value as shown below, Avaya IP Office
will send session refresh UPDATE or re-INVITE to the service provider every 5 minutes
(half of the specified value).

e Set Send Caller ID to Diversion Header. With this setting and the related configuration in
Section 5.2.4, Avaya IP Office will include the Diversion Header for calls that are redirected
via Mobile Twinning out the SIP Line to the PSTN. It will also include the Diversion Header

for calls that are forwarded out the SIP Line.

e ThinkTel supports using either REFER or re-INVITE for off-net call re-direction as in call
transfer. If REFER is used, the media path will be released from the enterprise after the call
is redirected. To use REFER, under Redirect and Transfer, set the Incoming Supervised
REFER field and Outgoing Supervised REFER field to Always. To use reINVITE, set
these fields to Never.

IPOffices || = SIP Line - Line 33 e -H X v
R 8OO @) SIP Love Transport {SIP URE|VolP | T38 Fax|SIP Credentials |SIP Advanced | Engineering
i~ Operator 3
Line Number 3 In Service v
T80 ITSP Doman Name tortrktpem.ca Check 0OS J
: p "1 . URI Type o Session Tamers
! 'l’ ' tncation Clood Refresh Methed Auto -
I ; Timer (seconds) £00 .
+-oly RAS{1
i @ Incoming Calt Rour |  Prefis Farwarding and Twinning
® “:’:"‘“ Port ) Natsonal Prefis 0 Ongmator number
: o Send Caller D Diversion Hesdes -
1 International Prefx 00
nt ode Redirect and Transfes
Name * System Defoun Incoming Superviced REFER Always -
Destriotion Ourgoing Supervzed REFER Alwayt -
Send 302 Moved Tenporarily
Ditgoing Slind REFER
{8 Authoezation Cods
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5.4.3. SIP Line — Transport Tab

Navigate to the Transport tab and set the following:

e Leave the ITSP Proxy Address blank. Avaya IP Office will determine the proxy address by
performing a DNS lookup on the domain entered in the ITSP Domain Name field in Section
5.4.2. It should be noted that the creation of the SIP trunk template forced a value to be
entered in this field. For the purposes of the template, this field was set with the value
entered in the ITSP Domain Name field in Section 5.4.2. Leaving the ITSP Proxy Address
blank or setting it to the ThinkTel domain will result in the same behavior.

e Setthe Layer 4 Protocol to UDP.

e Set Use Network Topology Info to the network port used by the SIP line to access the far-
end as configured in Section 5.2.1.

e Set the Send Port to 5060.

= SIP Line - Line 33 g -0 X | v | <] s

SIP Line| Transport SIP URI|VolP | T38 Fax|SIP Credentials| SIP Advanced| Engineering

ITSP Proxy Address

Metwork Configuration

Layer 4 Protocol [UDP v] Send Port 5060 =
Use Metwork Topelogy Info [LAN 2 v] 5060
Explicit DMS Server(s) ] ] ] a ] 0 ] ]

Calls Route via Registrar

Separate Registrar
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5.4.4. SIP Line — SIP Credentials Tab

SIP Credentials are used to register or authenticate the SIP Trunk with a service provider if required.
SIP Credentials are unique per customer and therefore customers must contact the service provider
to obtain the proper registration credentials for their deployment.

To enter the SIP Credentials, select the SIP Credentials tab and click Add. In the New SIP
Credentials area that appears, enter the information as shown below.

e Set User name, Authentication Name and Contact to the string provided by ThinkTel. This
is generally a 10-digit telephone number as shown below.

e Inthe Password and Confirm Password field, enter the password provided by ThinkTel.
e Inthe Expiry (mins) field, enter the time in minutes recommended by ThinkTel.
e Uncheck the Registration required box. ThinkTel did not require trunk registration.

Click OK.
= SIP Line - Line 33 ek - X v < s
|SIP LinelTransportlSIP URIlVoIP |T38 Fax| SIP Credentials ‘SIP AdvancedlEngineering
Index UserMame  Authentication Mame Contact Expiry (mins] Register Add...
Remowe
Edit...
Mew SIP Credentials
User name 4385550076
Authentication Mame 4385550976
Contact 4385550976
Password [T YY)
Confirm Password LILILITTT L
Expiry (mins) &0 =
Registraticn required |:|
CTM; Reviewed: Solution & Interoperability Test Lab Application Notes 25 of 43

SPOC 5/24/2016 ©2016 Avaya Inc. All Rights Reserved. ThinkIPO91



5.4.5. SIP Line — SIP URI Tab

Select the SIP URI tab to create a SIP URI entry or edit an existing entry. A SIP URI entry matches
each incoming number that Avaya IP Office will accept on this line. Click the Add button and the
New Channel area will appear at the bottom of the pane. For the compliance test, a single SIP URI
entry was created to match any DID number assigned to Avaya IP Office users.

Set Local URI to Use Internal Data. This setting allows calls on this line whose incoming
Request-URI matches the SIP Name set on the SIP tab of any User as shown in Section 5.6.
For outbound calls, the From header is populated with the SIP Name configured for the User
placing the call.

Set Contact and Display Name to Use Internal Data. This setting will cause the Contact
and Display Name data for outbound messages to be set from the corresponding fields on the
SIP tab of the individual User as shown in Section 5.66.

Set PAI to Use Internal Data. This setting directs Avaya IP Office to send the PAI header
(P-Asserted-ldentity) when appropriate. The PAI header will be populated from the data set
in the SIP tab of the call initiating User as shown in Section 5.66.

Set the Registration value to the credentials that was configured in Section 5.4.4.

Associate this line with an incoming line group by entering line group number in the
Incoming Group field. This line group number will be used in defining incoming call routes
for this line. Similarly, associate the line to an outgoing line group using the Outgoing
Group field. For the compliance test, the incoming and outgoing group 33 was specified.
Note that this group number can be different than the SIP Line number.

Set Max Calls per Channel to the number of simultaneous SIP calls allowed using this SIP
URI pattern.

Click OK.

CTM; Reviewed: Solution & Interoperability Test Lab Application Notes 26 of 43
SPOC 5/24/2016 ©2016 Avaya Inc. All Rights Reserved. ThinkIPO91



= SIP Line - Line 33 k- X v <]
sIP LinelTransport SIP URI |VoIP |T38 FaxlSIP‘ CredentialslSIP Adwvanced Engineering|
Channel Groups Via Local URI Contact Display Name PAI Credential Max Calls Add...
Remove
Edit...
Mew Channel
|
Via 192.168.10.232
Local URI Use Internal Data -
Contact Use Internal Data -
Display Name Use Internal Data -
PAT Use Internal Data -
Registration 1: 4385550976 -
Incoming Group 33
Outgoing Group EE
Max Calls per Channel 10 =

Additional SIP URIs may be required to allow inbound calls to numbers not associated with a user,
such as a short code. These URIs are created in the same manner as shown above with the exception
that the incoming DID number is entered directly in the Local URI, Contact, Display Name and
PAI fields.
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5.4.6. SIP Line —VoIP Tab

Select the VoI P tab to set the VVoice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below.

e Set the Codec Selection to System Default. The default codec set includes codecs G.711
ULAW 64K and G.729(a) 8K CS-ACELP which were used in the compliance test. G.711u
was configured as the preferred codec. If a different codec set is needed in a specific
customer deployment, set Codec Selection to Custom and use the left/right arrow buttons to
move the desired codecs between the Unused and Selected columns. Use the up/down
arrows to reorder the codec priority list.

e Select T38 Fallback for Fax Transport Support so that Avaya IP Office uses T.38 for
sending and receiving faxes on this SIP line. If the called destination does not support T.38,
the system will send a re-INVITE to change the transport method to G.711 (for falling back
to G.711 pass-through fax).

e Set the DTMF Support field to RFC2833. This directs Avaya IP Office to send DTMF
tones as out-of-band RTP events as per RFC2833.

e Uncheck the VoIP Silence Suppression option box.

e Check the Re-invite Supported option box.

e Check the PRACK/100rel Supported option box. This setting enables support by Avaya IP
Office for the PRACK (Provisional Reliable Acknowledgement) message on SIP trunks.

= SIP Line - Line 33 gk - | X | v <]

|SIP LinelTransportlSIP URI| VolP |T38 FaxlSIP Credentials | SIP Advanced Engineering|

[7] volP Silence Suppression

Re-invite Supported
Codec Selection ISYS'EE”" Default " [] Codec Lockdown

Allow Direct Media Path

. G.711 ULAW 64K ) o
G711 ALAW 64K Force direct media with phones

G.729(a) 8K CS-ACELP PRACK/L00rel Supported
G.7231 6K3 MP-MLQ
[7] G.711 Fax ECAN

<

B

Fax Transport Support IT38 Fallback v‘

DTMF Suppert |RFC2833 -|

Media Security | Disabled -
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5.4.7. SIP Line — T.38 Fax Tab
Select the T38 Fax tab. Leave the T.38 settings at the default values.

[0 sPunectness e -d X v <

|SIP Line | Transport| SIP URI|VelP | T38 Fax SIP Credentials | SIP Advanced |Engineering|

T38 Fax Version |3 - |
Scan Line Fix-up

fransport |UDPTL v| TFOP Enhancement

Redundancy i [] Disable T30 ECM

Low Speed |ﬂ i ["] Disable EFlags For First DIS

High Speed |':I - | [] Disable T30 MR Compression
TCF Method |Trans TCF - | [] MSF Owverride
Max Bit Rate (bps) |144|:m v| Country Code |ﬂ =

EFlag Start Timer (msecs) |l'5"3”:I 5 Vendor Code |':| :|

EFlag Stop Timer (msecs) |BUU : |

Tx Metwork Timeout (secs) |15':I

Usze Default Values

ok || cancel || Help
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5.4.8. SIP Line — Advanced Tab

Select the SIP Advanced tab. Set the parameter as shown below.

e Check the Emulate NOTIFY for REFER box. With REFER enabled, the Avaya 1100
Series Deskphones and Avaya Communicator for Windows expects to receive a NOTIFY
message to indicate that the referred (i.e., transferred) call was successful. 1f the NOTIFY is
not received from the far-end, then the call display will indicate that the transfer failed even
if the transfer was successful. If the Emulate NOTIFY for REFER box is checked, then
Avaya IP Office will send a NOTIFY message (on behalf of the far-end) to the Avaya 1100
Series Deskphones and Avaya Communicator for Windows.

Click the OK button at the bottom of the page (nhot shown).

= SIP Line - Line 33 cr - v
SIP Line 7ran‘.o|m;SP Ul |VolP | T38 Fa-iSP Credentisis SIP Advanced Engineenng
Addressing Mede
Association Method By Source IP address - Allow Empty INVITE
- Send Empty re-INVITE
Call Routing Method Request UR - 2
Aliow To Tag Change
Suppress DNS SRV Lookups P-Early-Meda Suppon None -
Send SilenceSupps Off
Jdentity
Uze Phaone Contest ) 2
:!eo: Connection I d -
Add user= phone Preservation
Use + for Intematianal
Use PAl for Prvacy Call Control
Use Domnain for PAI
3 Coll Initistion Timeout (3) 4
Swap From and PA
Calles 1D from From heades Coft Queving Timeout (m
Send From In Clesr Service Busy Resporse |436 - Busy Here -
Cache Auth Credentials Not Respond
on User Reipont ng " -
User-Agent and Server Headers Send $05-Request Timeoit 2/
Action oo CAC Location Allow Voicemal v
Larmat
Suppress Q850 Reason
Header
Errwilste NOTIFY for REFER v
No REFER f using Diversson
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5.5. Short Code

Define a short code to route outbound calls to the SIP line. To create a short code, right-click on
Short Code in the Navigation Pane and select New (not shown). In the Details Pane, configure the

parameters as shown below:

e Inthe Code field, enter the dial string which will trigger this short code, followed by a semi-
colon. The 9N; short code, used for the compliance test, will be invoked when the user dials

9 followed by any number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to N. The value N represents the number dialed by the user after

removing the 9 prefix. This value is passed to ARS (Section 5.8).
e Setthe Line Group ID to the ARS route to be used (Section 5.8).

Click the OK button (not shown).

IP Offices ey 9N:: Dial
=R BOOTP (2) Short Code
+-¢% Operator (3)
-5 Atlantic City Code n;
-39 System (1)
+-F7 Line (25) Feature Dial -
+-<2 Cantrol Unit (3)
114 Extension (25) Telephone Nurnber N
:% E:LSQ) Line Group ID 51: 5P SIP Route -
-8 Short Code (64) Locale [ -
- Service (0)
oy RAS (1) Force Account Code ]
+® Incoming Call Route (73) Force Authorization Code [
42 WAN Port (0)
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Optionally, add or edit a short code that can be used to access the SIP Line anonymously. In the
screen shown below, the short code *67N; is illustrated. This short code is similar to the 9N; short
code except that the Telephone Number field begins with the letter W, which means “withhold the
outgoing calling line identification”. In the case of the compliance test, when a user dialed *67 plus
the number, Avaya IP Office would include the user’s telephone number (DID number assigned to
the user) in the P-Asserted-ldentity (PAI) header and would include the Privacy: id header in the
outbound INVITE message. Consequently, ThinkTel would prevent presentation of the caller id to
the called PSTN destination.

= *67N:: Dial 5 - X | vl|<|>
Short Code

Code BTM;

Feature Dial -

Telephone Mumber WN

Line Group ID 51: 5P SIP Route -

Locale ’ -

Force Account Code [}

Force Authorization Code [
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5.6. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP Line.
To configure these settings, first navigate to User->Name in the Navigation Pane, where Name is
the name of the user to be modified. In the example below, the name of the user is Extn243. Select
the SIP tab in the Details Pane. The SIP Name and Contact are set to one of the DID numbers
assigned to the enterprise by ThinkTel. The SIP Display Name (Alias) can optionally be configured
with a descriptive text string. The value entered for the Contact field will be used in the Contact
header for outgoing SIP INVITE to the service provider. The value entered for the SIP Name is used
as the user part of the SIP URI in the From header for outgoing SIP trunk calls.

If outbound calls involving this user and a SIP Line should be considered private, then the
Anonymous box may be checked to withhold the user’s information from the network (or
alternatively use the *67N; short code as defined in Section 5.5).

IP Offices = Extn243: 243 ef -8 X v <>

‘5 BOOTP (2) User | VYoicemail | DMD | Short Codes | Source Mumbers | Telephonyl Forwarding | Dial In |
* Operator (3)
B2 Atlantic City Voice Recording | Button Programming | Menu Programming | Mobility | Group Membership |

B¢ System (1) Announcements | SIP | Personal Directory | Web Self-Administration|

-1 Line (25)

= Control Unit (3} SIP Mame 4385550978

[-4 Extension (25)

E-§ SIP Display Mame (Alias) Bxtn243

5@ Group (1)

8% Short Code (64) Contact 4385550978

4B Service (0)

e Inceming Call Route (73) [C] Anonymaus
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5.7. Incoming Call Route

An incoming call route maps an inbound DID number on a specific line to an internal extension.
This procedure should be repeated for each DID number provided by the service provider. To create
an incoming call route, right-click Incoming Call Route in the Navigation Pane and select New (not
shown).

5.7.1. Incoming Call Route — Standard Tab
On the Standard tab in the Details Pane, enter the parameters as shown below:

e Set the Bearer Capability to Any Voice.
e Setthe Line Group ID to the Incoming Group of the SIP Line defined in Section 5.4.5.
e Set the Incoming Number to the incoming DID number on which this route should match.
IP Offices = 33 4385550978 £ - XKl vl >
a BOOTP (2) Standard | Voice Recording | Destinations|
4% Operator (3)
=-#57 Atlantic City
8}‘? E}‘Ste(r;ifl) Bearer Capability [Any Voice vl
-1 Line
H-“2r Control Unit (3] Line Group ID 33 -
[+ 48 Extension (25)
- User (27) Inceming Mumber 4385550978
[y G
E]-"a SF:DD:ItpC%:LE i64) Incoming Sub Address
..... Servi 0 )
EJ-"% R:r;l(cle)( ) Inceming CLI
Y incoming Cai rout= 2 | IR | 5
----- EE WAN Port (0)
""" @& Directory (0} Priority 1-Low - |
----- £ Time Profile (0)
-8 Firewall Profile (1) Tag
c-Jll IP Route (4)
..... #m Account Code (0) Haold Music Source [System Source vl
; #—IS::ZT(%S) Ring Tone Override Mene -
#-§iy User Rights (8)
- ARS (13)

5.7.2. Incoming Call Route — Destination Tab

On the Destinations tab, select the destination from the pull-down list of the Destination field. In
this example, incoming calls to the DID number 4385550978 on Incoming Group 33 are to be routed
to the user “Extn243” at extension 243.

W —

= 33 4385550978 £ - Klv < |>
Standard | Yoice Recording Destinations
TimeProfile Destination Fallback Extension
b | Default Value 243 Extn243 I~ -
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The screen below shows the mapping of inbound calls to IP Office VVoicemail Pro for message

retrieval.
= 33 4385550980 ek - X < | >
Standard | Voice Recording | Destinations
TimeProfile Destination Fallback Extension
b Default Value VoiceMail B v
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5.8. Alternate Route Selection (ARS)

Alternate Route Selection (ARS) is used to route outbound traffic to the SIP line. To define a new
ARS route, right-click ARS in the Navigation pane and select New. In the Details pane that appears,
a collection of matching patterns (similar to short codes) can be entered to route calls as shown
below.

For the compliance test, two entries were created. The first entry matches on 0 and the second entry
matches on any other number N.

To create an entry, click the Add button and enter the following in the pop-up window (not shown).
¢ In the Code field, enter the pattern to match the number passed to ARS from the short code
in Section 5.5 followed by a semi-colon. The value N will match any number.

e Set Feature to Dial. This is the action that the entry will perform.

e For Code 0, set Telephone Number to 0”@domain”, where domain is the ThinkTel domain
used to configure the trunk in Section 5.4.2. Adding the domain in this field was required to
ensure that the correct host appeared in the outbound Request-URI header when dialing 0.
This was not required when matching on any other dialed number as shown next. Since
ThinkTel does not support dialing an operator (0) (Section 2.2), the Code 0 entry is not
strictly required for interoperability. However, adding this entry will allow the Avaya IP
Office configuration to support dialing O if ThinkTel adds this capability in the future.

e For Code N;, set Telephone Number to N. This field is used to construct the Request-URI
and To headers in the outgoing SIP INVITE message. The value N represents the complete
number passed to ARS.

e Setthe Line Group Id to the outgoing line group number defined on the SIP URI tab on the
SIP Line in Section 5.4.5. This entry will use this line group when placing the outbound call.

Click the OK button (not shown).

E o it jof -9 X ¢

ARS Route Il sl Secondary Dial tone
Route Neme 5P SP Rowte
Died Deday Time Symtem Defauit (4) Check User Call Barring

Descrption

In Service J Ougt of Service Route «None» -

Time Profile — Ot Of Hours Route <Mone> -

Code Telephone Number Feature Lne Growp ID Add

0" Stortritpemica D Bt
N N Ol
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5.9. Save Configuration

Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.

The following will appear, with either Merge or Immediate selected, based on the nature of the
configuration changes made since the last save. Note that clicking OK may cause a service
disruption. Click OK to proceed.

CTM; Reviewed:
SPOC 5/24/2016

a

Save Configuration lecsinz: l_ﬂhl

IP Office Settings
Atlantic City

Configuration Reboot Mode
@ Merge
1 Immediate
") When Free
) Timed
Reboot Time
09:25

Call Barring

| ok || cancel |[ Hep
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6. ThinkTel SIP Trunking Configuration

ThinkTel is responsible for the configuration of its SIP Trunking Service. The customer will need to
provide the IP address used to reach the Avaya IP Office at the enterprise site (i.e., the IP address of
the WAN port on the Avaya IP Office). ThinkTel will provide the customer the necessary
information to configure the Avaya IP Office including:

e ThinkTel SIP Trunking Service domain.

e Transport and port for the ThinkTel SIP connection to Avaya IP Office.
SIP Credentials

DID numbers to assign to users at the enterprise.

Supported codecs and their preference order.
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7. Verification Steps

This section provides verification steps that may be performed in the field to verify that the solution
is configured properly.

7.1. Avaya IP Office System Status

Use the Avaya IP Office System Status application to verify the SIP Line channels state and to check
alarms:

e Launch the application from Start = Programs = IP Office = System Status on the
Avaya IP Office Manager PC. Login with appropriate credentials. Select the SIP Line under
Trunks from the left pane. On the Status tab in the right pane, verify the Current State is
Idle for channels where no active calls are currently in session. The state should be
Connected for channels engaged in active calls.

AVAyA IP Office System Status

Help Snapshet LogOff Exit About

Status  Utilization Summary Alarms  Registration
SIP Trunk Summary
- Line Service State: In Service
Li"“:s -8 Peer Domain Name: tor. trk. tprm.ca
::::::; Resolved Address: 182.168.250.100
Line:19 Line Mumber: 33
Line:20 Mumber of Administered Channels: 10
Line:21 Mumber of Channels in Use: 0
L= Administered Compression: G711Mu, GT11 A, G729 A, G7231
t:::ii Enable Faststart: Off
Line:26 Silence Suppression: off
Line:26 Media Stream: RTP
Line:27 Layer 4 Protocol: ucp
SIF Trunk Channel Licenses: Unlimited . %
SIP Trunk Channel Licenses in Use: 0
SIP Device Features: REFER. {Incoming and Outgoing)
Channel U... Call Current Timein Remote Co... Conn... Caller Other Party Direct... Round Receive Receive Trans... Trans...
r te State Media... IDor... onCall Trip ... Jitter Pack..
1 Ide |01:40... -
2 Idle |3 day... i
3 Idle |3 day... |
4 ide |3 day... 3
5 Idle |3 day...
[ Idle |3 day...
7 Idle |3 day...
ldeJ2da -
Trace [ Trace Al ] ’ Pause ] [ Ping ] Call Details Graceful Shutdown ] ’ Force Qut of Service ] [ Print...
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e Select the Alarms tab and verify that no alarms are active on the SIP Line.

Status  Utilization Summary Alarms Registration

Alarms for Line: 33 SIP tor.trk.tprm.ca

Last Date Of Error Ocourrences Error Description
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7.2. Avaya IP Office Monitor

The Monitor application can be used to monitor and troubleshoot Avaya IP Office. Monitor can be
accessed from Start = Programs > IP Office = Monitor on the Avaya IP Office Manager PC.
The application allows the monitored information to be customized. To customize, select Filters 2>
Trace Options ... as shown below:

3} Avaya IP Office SysMon

| File Edit View [Filters| Status Help

== [ trace Options .. ctrisT EI
|

nm Send To Syslog

The following screen shows the SIP tab, allowing configuration of SIP monitoring. In this example,
Standard SIP Events and the SIP Rx and SIP Tx boxes are checked.

T | VPN | WAN | SCN | Jade |
a4TM | cal | DTE | EConf | FrameRelsy | GOD | H.323 | Intedface |
ISDN | Key/Lamp | Directory | Media | PPP | B2 | Routing | Sewvices SIP ]Syslem

Events

v Sip 'Slandard v [~ STUN [~ SIP Dect
Packets
[~ SIP Reg/Opt Rz [~ SIP Misc Rx
[~ SIP Reg/Opt Tx [ SIP Misc Tx
[~ SIPCallRx [~ Crm Notify Rx
¢ |~ Cm Notify Tx
W SipRx IP Filter (nnn.nnn.nnn.nnn)
V¥ SipTx |
Default All | ClearAll | TabCleardll| TabSetai | ok | cancel |
SaveFie |  LoadFie | LoadPatalFie|  SelectFie |

8. Conclusion

The ThinkTel SIP Trunking Service passed compliance testing with Avaya IP Office 9.1. These
Application Notes describe the configuration necessary to connect Avaya IP Office 9.1 to ThinkTel
as shown in Figure 1. Test results and observations are noted in Section 2.2.
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9. Additional References

Avaya IP Office 9.1

[1] IP Office Documentation Catalog, Release 9.1, Documentation number 16-604278 Issue 2.1,
December 2014.

[2] IP Office 9.1 Platform Solution Description, Issue 01.17, February 2016.

[3] Avaya IP Office 9.1 Deploying Avaya IP Office Platform IP500 V2, Document Number 15-
601042 Issue 30za, February 2016.

[4] Avaya IP Office 9.1 Administering Voicemail Pro, Document number 15-601063 Issue 10m,
February 2016.

[5] Administering Avaya IP Office Platform with Manager, Issue 10.38, February 2016.

[6] Avaya IP Office 9.1 Using System Status, Document Number 15-601758 Issue 10f, August 2015.

[7] Avaya IP Office 9.1 Using IP Office System Monitor, Document Number 15-601019, Issue 06g,
February 2016.

[8] Avaya IP Office 9.1 H.323 Telephone Installation Notes, Document Number 15-601046, Issue
20h, December 2015.

[9] Avaya IP Office 9.1 SIP Extension Installation, Issue 4a, May 2015.

Additional IP Office documentation can be found at
http://marketingtools.avaya.com/knowledgebase/.

Product documentation for the ThinkTel SIP Trunking Service is available from ThinkTel. See
Section 2.3 on how to contact ThinkTel.
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products specified in these Application Notes.

Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya DevConnect
Program at devconnect@avaya.com.
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